Transcend Enterprise Manager for Windows

Getting Started

About This Guide 

Introduction 

This guide describes how to install the Transcend Enterprise Manager for Windows application.. 

How to Use This Guide 

The following table shows where to find specific information. 

If you are looking for information about:
 Turn to:
 
Installing Transcend Enterprise Manager.
 Chapter 1
 
Additional information for WorkGroup PC Links
 Chapter 2
 
Release notes for Transcend Enterprise Manager
 separate document
 
Getting technical support.
 Appendix A
 
Conventions 

The following tables list conventions that are used in this guide. 

Convention
 Description
 
"Enter" vs. "Type"
 When the word "enter" is used in this guide, it means type something, then press the Return or Enter key. Do not press the Return or Enter key when an instruction simply says "type."
 
Text represented as screen display 
 This typeface is used to represent displays that appear on your terminal screen, for example:

NetLogin:
 
Text represented as commands
 This typeface is used to represent commands that you enter, for example:

SETDefault !0 -IP NETaddr = 0.0.0.0
 
Keys
 When specific keys are referred to in the text, they are called out by their labels, such as "the Return key" or "the Escape key," or they may be shown as or  

If two or more keys are to be pressed simultaneously, the keys are linked with a plus sign (+), for example:

Press 
 
Italics
 Italics are used to denote new terms or emphasis.
 
Icon
 Type
 Description
 

 Information Note
 Information notes call attention to important features or instructions.
 

 Caution
 Cautions alert you to personal safety risk, system damage, or loss of data.
 

 Warning
 Warnings alert you to the risk of severe personal injury.

 
Related Publications 

The list below shows other guides and publications you may want to refer to while using Enterprise Manager. 

·For information about the general operation of Enterprise Manager, see Volume 1 of the User Guide. 

·For detailed information about managing different devices using Enterprise Manager, see Volume 2 of the User Guide. 

·For information about using the WorkGroup PC Links component, see the WorkGroup PC Links User Guide. 

·For information about using RMON tools, see the RMON Manager for Windows User Guide. 

·For information about installing and using the devices that can be managed by Enterprise Manager, see the relevant device section of the User Guide. The individual manuals you may want to refer to are listed in each part of this guide. Alternatively you can look at the on-line documentation provided on the 3com virtual library CD-ROM. 

 1 Installation 

This chapter contains the following topics: 

·About Enterprise Manager 

·What's New in this Release 

·Installation and Upgrade 

·Installation Requirements 

·Minimum System Configuration 

·Installing with IPX 

·Installing Enterprise Manager 

·Starting Enterprise Manager 

·Starting Status View 

·Starting ONdemand NCS 

·Workstation PC Link Feature Summary 

·Installing Transcend Network Assistant 

About Enterprise Manager 

Transcend Enterprise Manager for Windows provides an economical, easy-to-use graphical management system for the following devices: 

·OfficeConnect Hub/8TPM 

·SuperStack II Hub 10, Hub 100, HubTR 

·SuperStack II Switch 1000, Switch 2200, Switch 3000 

·LinkBuilder® FMSÔ, FMS II, 10BTi TP/8i hubs, and FMS II Bridge 

·LinkBuilder Focus, TR, and TR II Token Ring hubs 

·LinkBuilder ECS hubs 

·LinkBuilder MSHÔ hubs 

·LinkBuilder FDDI hub 

·NETBuilder®, NETBuilder II, SuperStack IIÔ NETBuilder Bridge/Routers and Boundary Routers 

·LinkSwitch switching hubs 

·LANplex® 2016, 2500 & 2600 switches 

·EtherLink® and TokenLink® adapters 

Enterprise Manager gives you an accurate view of your network, quick and easy troubleshooting is provided by color-coded icons, and you can view network trends at a glance via a comprehensive set of graphical statistics and events. Enterprise Manager provides a familiar Microsoft® WindowsÔ interface, point and click operation, and automatic discovery of all SNMP devices. 

The different Enterprise Manager components provide you with realistic representations of the corresponding devices on your network, which you can manage and monitor via a set of easy-to-use windows. 

The WorkGroup PC Links component provides grouping views of PCs including management of their network activity and asset information. 

The RMON-based statistics provide an accurate picture of network performance, enabling you to pinpoint performance patterns in the network, and identify potential problem areas, such as bottlenecks, before the condition disrupts network performance. For these reasons, RMON-based tools are a real asset for network-wide performance analysis and capacity planning. 

To use Enterprise Manager effectively, you need to be familiar with Microsoft Windows 95 or Windows NT. If you need to know more about Microsoft Windows, refer to the Microsoft Windows 95 User's Guide, the Microsoft Windows NT Workstation System Guide, or the Microsoft Windows NT Networking Guide Version 3.5, part of the Microsoft Windows NT Resource Kit from Microsoft Press. 

What's New in this Release 

This version of the software provides the following new tools and device support: 

·Window 95 and Windows NT Workstation 3.51 support 

·ONdemand provides management for Chipcom devices 

·StatusView provides redesigned applications that help users manage large blocks of LANplex devices. SuperStack View enables you to group devices into a single stacked view 

·Support for the following new devices: 

·FMS Advanced RON Management Module 

·SuperStack II Hub 10 

·SuperStack II Hub 100 

·SuperStack II Hub TR 

·SuperStack II Switch 1000 

·LinkSwitch 3000 TP 

·SuperStack NETBuilder 

·Enhanced support for MSH (including Distributed RMON and Fast Ethernet) 

·Enhanced support for LinkSwitch 1000 (including RMON management tools, resilience, PACE, VLAN and Switching Configuration) 

·Enhanced support for LinkSwitch 3000 (including RMON management tools, VLAN and Switching Configuration) 

·Enhanced support for LANplex 2500 (Fast Ethernet support) 

·Enhanced support for LANplex 6004 and 6012 (including LMMplus, Token Ring switching, Tri-media Module and Fast Ethernet support) 

·NETBuilder device management support for SuperSTackÔ II NETBuilder models 52x, NETBuilder II Multiprocessor ATMLink module, Token Ring Module II (TRM II), and software version 9.0. 

·Enhanced support for FMS TR hubs (including a view of attached stations 

· 

Installation and Upgrade 

Please ensure you install your software in the sequence shown in Figure 1-1. 


FIG 

Figure 1-1 Installation Overview 

Installation Requirements 

Before you install Transcend Enterprise Manager, you must have installed and configured one or both of the following: 

·WINSOCK compliant TCP/IP package - Enterprise Manager requires the TCP/IP protocol stack that comes with Microsoft Windows 95 and Microsoft Windows NT Workstation 3.51. Be sure that this version of TCP/IP are installed on your PC before installing Enterprise Manager. 

·Novell NetWare® client - If you want to use Enterprise Manager to discover and manage devices with IPX protocols with Windows 95. 

You must ensure that these networking packages are working before you install Enterprise Manager. Check TCP/IP by pinging another device on your network. Check Novell NetWare by logging onto a server. Do not install Enterprise Manager until you have successfully completed these checks. 

Minimum System Configuration 

The Enterprise Manager software requires an IBM compatible PC, with at least an 80486 CPU. Your management system must also include the following: 

·Microsoft Windows 95 or Microsoft Windows NT Workstation 3.51. 

·Minimum of 125MB available hard disk space. 

·Minimum of 16MB RAM, with 24MB RAM recommended. All RAM above the first megabyte must be configured as extended memory. 

·CD-ROM drive. 

·VGA color monitor or above. 

·Mouse that is supported by Windows. 

·Network adapter. Enterprise Manager has been verified with the following network adapters: 

·3Com EtherLink II® (3C503-16-TP) 

·3Com Etherlink II PCI Bus Master 10BaseT only (3C590-TPO) 

·3Com EtherLink III Family (3C509B, 3C579-TP) 

·3Com Fast Ethernet 10/100 PCI (3C595-TX) 

·3Com Fast Ethernet 10/100 EISA (3C597-TX) 

·3Com TokenLink III (3C619C) 

·3Com TokenLink III 16/4 EISA (3C679C) 

If you install Enterprise Manager with a network adapter that is not one of those listed, 3Com may not support your installation. 

Use the checklist in Figure 1-2 to ensure your system is suitable for installing the Enterprise Manager software. 
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Figure 1-2 System Requirements Checklist 

Installing with IPX 

Before installing Enterprise Manager, you must install a Novell NetWare client. Additionally you must configure Windows to use NetWare. 

To configure IPX for Microsoft Windows 95: 

1Select My Computer. 

2Open the Control Panel and select Network. 

3Add the client or the protocol you want. 

Restart Windows 95 for this to take effect. 

See the Windows 95 documentation for more information. 

When managing devices with IPX, you may run out of IPX sockets if you open too many device views and/or graphs. The error message Lack of IPX Resources is displayed. You can prevent this by creating (or editing) the Novell SHELL.CFG file and changing the IPX socket line to read as follows: 

IPX Sockets = 60 

You must reboot your PC after making this change for it to take effect. 

Enterprise Manager for Microsoft Windows 95 only supports the 16-bit NetWare 1.x client that comes with NetWare 4.1 servers. It does not support NetWare on Microsoft Windows NT. See the Release Notes for more information. 

Installing Enterprise Manager 

You install Enterprise Manager from the CD-ROM. Use the installation program to carry out a new installation of Enterprise Manager or to upgrade from an earlier version of Enterprise Manager. Upgrading the software preserves any networks you have created and does not affect any device configuration you have already carried out. 

When you install the Enterprise Manager software, the installation program prompts you to provide information about your system. 

Before installing Enterprise Manager, make sure that your network software is running. 

To install the Enterprise Manager for Windows software: 

1Start Windows 95 or Windows NT. (In Windows NT, log on with Admin privileges.) 

Ensure that any open applications are closed down, including any existing versions of Enterprise Manager or WorkGroup Manager, 

2Run the setup program from the Enterprise Manager CD-ROM. 

In Windows NT, select Run from the File menu in the Program Manager window. 

Windows 95 will automatically boot from the CD-ROM when it is inserted. Optionally, you can select Start/Run from the Taskbar; or, in the Control Panel, select Add/Remove Programs, and use the Install/Uninstall option. 

You will see a dialog box for the installation program. If you don't see the dialog box, in the Command Line box, type drive:\SETUP (where drive is the letter of your CD-ROM drive) and click on OK. 

The installation program starts and checks your system configuration. 

The installer menu lets you select Transcend Platform, ONdemand, Status View, or Exit the menu. 

3Click on the icon of the program you want to install; usually, you begin by installing Transcend Platform. 

You must install each Enterprise Manager program separately; when installation of a program is complete, the installation program returns to the Installation menu. You may select another Enterprise Manager program to install, or select Exit. When you are done installing programs, select Exit to end the installation program. 

Each Enterprise Manager program presents options for selecting network protocols used to gather information from your network, entering your name and company information for registration, choosing the directory into which the program is installed, and selecting Enterprise Manager components. 

ONdemand provides options for typical, minimum or custom installations. The default (recommended) choice is typical. ONdemand also prompts for a Telnet option; click on Next to choose the default Telnet setting. 

The StatusView installer program presents a dialog box for modifying your system's AUTOEXEC.BAT file; the default value permits StatusView to modify the AUTOEXEC.BAT file. 

The installation program displays the System configuration dialog box. 

The remaining steps apply to the Transcend platform: 

4Select a network configuration by checking either Winsock or Novell, or both (they may co-exist on the same system). 

When you select a network configuration, some buttons may be deactivated, depending on the available network configuration. 

Check the Enable TCP/IP box to enable Enterprise Manager to gather information from devices using this communications protocol. 

Check the Enable IPX box to enable Enterprise Manager to gather information from devices using this communications protocol. 

You can enable both TCP/IP and IPX if you want to manage and/or recognize devices using both these protocols. 

5Click on Next. 

The installation program displays the User Information dialog box. 

6Enter your name and company information; your address and other registration information are optional. 

7Click on Next. 

The installation program displays the Select Destination Directory dialog box. 

8The dialog box lets you choose the directory into which the Enterprise Manager program is installed. 

The default installation directory is C:\TRANSCND. If you want to install the Enterprise Manager software in a different directory from the default, in the Install to: field enter the new drive and directory information. 

The default directory option is recommended. If you use another directory, see the Release Notes for more information. 

If you choose a directory that does not exist, the installer program asks if you want to create it. 

If you change directories when you reinstall or upgrade, you may lose valuable historical application information. 

The installation program creates the default (or specified) directory. 

The default value is Full Install. The installation program displays the amount of hard disk space available; if your installation option requires more disk space than is available, the installation program displays a warning message and halts the installation process. 

The installation program displays the Select Program Folder dialog box. 

9Select a program folder for the program you are installing. 

The installation program displays the Network Devices dialog box (this is optional). 

10Enter device information that will be used by 3Com for market research purposes. 

11Click Next. 

12The installation program displays a Final Confirmation review dialog box, showing you the options you have selected for installing that Enterprise Manager program. You may continue installation, go back to change some of your selections, or cancel installation. 

13If you choices are correct, click Install. 

14Click OK. 

When installation is complete, the installer program displays a Setup Complete message. 

The installation programs returns to the opening menu. You can continue to install other applications, or quit by clicking the Exit button. 

You must reboot for these changes to take place. 

Starting Enterprise Manager 

When you have installed Enterprise Manager, the Transcend program group appears in your Program Manager window or Stat window. The Transcend program group contains a set of items, including: 

·Enterprise Manager - Manages networking devices and monitors your network. 

·WorkGroup PC Links - Provides management of PCs and PC groups. See the Transcend WorkGroup PC Links User Guide for more information about managing PCs. 

·Interactive BOOTP - Invokes the BOOTP server independently of Enterprise Manager. 

·TFTP Server - Invokes the TFTP server independently of Enterprise Manager 

To start Enterprise Manager, double-click on the Enterprise Manager icon. The Enterprise Manager window and the Login dialog box are displayed. Enter the user name "admin", and click on the OK button. Enterprise Manager is installed with one user, called "admin", already set up. You can add more users and assign passwords to them to prevent unauthorized access to Enterprise Manager. 

Before using Enterprise Manager, read the Release Notes. 

Starting Status View 

When you have installed Status View, it provides five separate tools that you can use to monitor your network: 

·Inventory Manager - Permits you to construct a database of devices and groups of these devices to manage with the Status View tools. 

You must run the Inventory Manager to create the database before running other Status View applications. All other Status View tools use the database so it must be set upfirst. 

·Global Configuration - Allows you to apply certain configurations to a managed device or set of devices on your network. 

·Status Watch - Helps you to monitor devices on your network by monitoring network conditions, detecting problems, and notifying you through color-coded icons and automated responses. 

·MACWatch - Allows you to monitor MAC addresses stored within devices on your network. 

·Utilization Watch - Monitors utilization of switched Ethernet ports and FDDI paths, as well as threshhold clecking of these ports and paths. 

Starting ONdemand NCS 

When you have installed ONdemand, you have a graphical interface for managing 3Com ONcore, ONline and ONsemble hubs and modules. 

·If you do not have an assigned user name and password, you must log on as user name: ROOT and password: ROOT, the pre-configured user account. This gives you full administrator privileges, so you can change the user name and password. 

1To start ONdemand, click on the ONdemand icon. This opens the Device Panel which is empty. You may now add devices and assign them agents. 

2Create an agent by using the Edit menu and selecting Agent. 

3Click the Create button. You are prompted for an IP address of the device you want to manage. 

4Select Device from the Edit menu. 

5Give the device a name. The IP address appears in the Unassigned Agent window. 

6Assign the unassigned agent to the device. 

7Return to the Device Panel. The agent you just created is represented by an icon with a blue border. 

When ONdemand successfully polls this agent for the first time, the border is changed to green. 

See the ONdemand User's Guide for further information. 

Workstation PC Link Feature Summary 

Transcend PC Links SmartAgent software, when used with the WorkGroup PC Links management tools provided by Enterprise Manager, allows remote management of PC network activity and information. SmartAgent software does this with driver agents on each PC and one SoftHub® on each LAN. SmartAgent software consists of driver agent files for each NetWare ODI-compliant and NDIS-compliant adapter, and one SoftHub. 

Transcend Network Assistant is an application that supports remote editing of files on network users' PCs. When Transcend Network Assistant is installed and running on a user's PC, a network manager or administrator can edit files on that PC without leaving the PC where Enterprise Manager is installed. 

Figure 1-3 shows how SmartAgent software allows computers with Ethernet adapters to be managed from Enterprise Manager. The thick dotted line represents remote or local SNMP traffic. SoftHub, as a proxy agent, communicates with Enterprise Manager. The thin dotted lines represent local driver agent traffic. 

The PC Links SmartAgent architecture: 

·Uses drivers that use only a small amount of memory (6KB) 

·Avoids the need for each PC to have an IP address 

·Provides rapid discovery and updating of information 

·Minimizes management traffic on network backbones and routers 

PC Link operates on a Transcend workstation, running Windows 95 or Windows Workstation NT. The primary SmartAgent application runs on a PC, together with the Network Admin software, with either DOS or Windows 3.1. Softhub operates on a dedicated PC under DOS. 

For more information, refer to the User's Guide for each product. 

PC Link SmartAgent is no longer supplied on diskettes and should be installed from the /SMRTAGNT directory on the Transcend Enterprise Manager CD-ROM. 

If you need to install WorkGroup PC Links on to a PC with no CD-ROM drive, you can copy the source files to floppy disks from the Enterprise Manager CD-ROM. The source files are in the /SMRTAGNT/DISK* directories. 

Be aware that you are working with a variety of operating systems: Workgroup PC Links runs on Windows 95 and Windows NT; SmartAgent software runs on DOS or Windows 3.1; SoftHub runs on DOS; and Transcend Network Assistant runs on Window 3.1/3.11. 


FIG 

Figure 1-3 Managing PCs with SoftHub 

 2 Additional Information for WorkGroup PC Links 

This new release of the Transcendâ WorkGroup PC Links and the Transcend Network Assistant (TNA) applications has two added features for your use in managing files. 

As described in Chapter 7 of the Transcend WorkGroup PC Links User Guide, you can view and edit the files of a PC remotely. You do this from the PC that has the Transcend WorkGroup PC Links application installed. For example, you could view and edit a PC's CONFIG.SYS or AUTOEXEC.BAT file. 

Now, in addition to viewing and editing, you can create and delete files on the remote PC. The following section describes the new capabilities. 

Creating and Editing Files 

You can edit files on PCs being managed by the application. Editing is done within the Files - PC Zoom window. The user of the PC being managed can monitor and disable access to the file system, as described in Chapter 7. 

Remember the following: 

·The size of the file to be edited must be 32 KB or less. 

·If you specify a non-ASCII file, many characters in the edit box will appear different from those in the original file. Even though it is possible to edit non-ASCII files, it is not recommended. 

To edit a file, proceed as follows: 

1Double-click on the PC of interest in any application window. 

A PC Zoom window appears. 

2Click the Files button. 

The window changes to resemble the one shown in Figure 3-1. The window title contains the PC's user name, node name, location, or MAC address (depending on which option is chosen under PC Names in the Options menu). 
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Figure 2-1 Files - PC Zoom window 

3Specify the filename, directory path, and drive of the file to be edited in the File Name, Directories, and Drives boxes. To create a new file, enter a new filename and path in the boxes. 

4Click the Edit button or double-click on the filename in the Files list box. 

The file contents appear in the box at the bottom of the window. If you are creating a new file, begin entering the file contents in the box. 

5Edit the file. 

You can copy information from the clipboard into the file contents area. 

6Save the updated file contents. 

If the file is new, a confirmation windows queries whether you want to create the new file or not. Click Yes to create the file. 

Deleting Files 

You can delete files from a managed PC. Deleting files is done in the Files-PC Zoom window. 

To delete a file, proceed as follows: 

1Double-click on the PC of interest in any application window. 

A PC Zoom window appears. 

2Click the Files button. 

The window changes to resemble the one shown in Figure 3-1. 

3Select the file(s) you want to delete. 

4Click the Delete button. 

A confirmation windows queries whether you want to delete the file or not. Click Yes to delete the file. 

There is no undelete function. 

 Limited Warranty 

HARDWARE: 3Com warrants its hardware products to be free from defects in workmanship and materials, under normal use and service, for the following lengths of time from the date of purchase from 3Com or its Authorized Reseller: 

Internetworking products
 One year
 
Network adapters
 Lifetime
 
Ethernet stackable hubs and Unmanaged Ethernet fixed port repeaters
 Lifetime* (One year if not registered)
 
*Power supply and fans in these stackable hubs and unmanaged repeaters
 One year
 
Other hardware products
 One year
 
Spare parts and spares kits
 90 days
 
If a product does not operate as warranted during the applicable warranty period, 3Com shall, at its option and expense, repair the defective product or part, deliver to Customer an equivalent product or part to replace the defective item, or refund to Customer the purchase price paid for the defective product. All products that are replaced will become the property of 3Com. Replacement products may be new or reconditioned. Any replaced or repaired product or part has a ninety (90) day warranty or the remainder of the initial warranty period, whichever is longer. 

3Com shall not be responsible for any software, firmware, information, or memory data of Customer contained in, stored on, or integrated with any products returned to 3Com pursuant to any warranty. 

SOFTWARE: 3Com warrants that the software programs licensed from it will perform in substantial conformance to the program specifications therefor for a period of ninety (90) days from the date of purchase from 3Com or its Authorized Reseller. 3Com warrants the magnetic media containing software against failure during the warranty period. No updates are provided. 3Com's sole obligation hereunder shall be (at 3Com's discretion) to refund the purchase price paid by Customer for any defective software products, or to replace any defective media with software which substantially conforms to 3Com's applicable published specifications. Customer assumes responsibility for the selection of the appropriate applications program and associated reference materials. 3Com makes no warranty that its software products will work in combination with any hardware or applications software products provided by third parties, that the operation of the software products will be uninterrupted or error free, or that all defects in the software products will be corrected. For any third party products listed in the 3Com software product documentation or specifications as being compatible, 3Com will make reasonable efforts to provide compatibility, except where the non-compatibility is caused by a "bug" or defect in the third party's product. 

STANDARD WARRANTY SERVICE: Standard warranty service for hardware products may be obtained by delivering the defective product, accompanied by a copy of the dated proof of purchase, to 3Com's Corporate Service Center or to an Authorized 3Com Service Center during the applicable warranty period. Standard warranty service for software products may be obtained by telephoning 3Com's Corporate Service Center or an Authorized 3Com Service Center, within the warranty period. Products returned to 3Com's Corporate Service Center must be pre-authorized by 3Com with a Return Material Authorization (RMA) number marked on the outside of the package, and sent prepaid, insured, and packaged appropriately for safe shipment. The repaired or replaced item will be shipped to Customer, at 3Com's expense, not later than thirty (30) days after receipt by 3Com. 

WARRANTIES EXCLUSIVE: IF A 3COM PRODUCT DOES NOT OPERATE AS WARRANTED ABOVE, CUSTOMER'S SOLE REMEDY SHALL BE REPAIR, REPLACEMENT, OR REFUND OF THE PURCHASE PRICE PAID, AT 3COM'S OPTION. THE FOREGOING WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, EITHER IN FACT OR BY OPERATION OF LAW, STATUTORY OR OTHERWISE, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 3COM NEITHER ASSUMES NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR IT ANY OTHER LIABILITY IN CONNECTION WITH THE SALE, INSTALLATION, MAINTENANCE OR USE OF ITS PRODUCTS. 

3COM SHALL NOT BE LIABLE UNDER THIS WARRANTY IF ITS TESTING AND EXAMINATION DISCLOSE THAT THE ALLEGED DEFECT IN THE PRODUCT DOES NOT EXIST OR WAS CAUSED BY CUSTOMER'S OR ANY THIRD PERSON'S MISUSE, NEGLECT, IMPROPER INSTALLATION OR TESTING, UNAUTHORIZED ATTEMPTS TO REPAIR, OR ANY OTHER CAUSE BEYOND THE RANGE OF THE INTENDED USE, OR BY ACCIDENT, FIRE, LIGHTNING, OR OTHER HAZARD. 

LIMITATION OF LIABILITY: IN NO EVENT, WHETHER BASED IN CONTRACT OR TORT (INCLUDING NEGLIGENCE) SHALL 3COM BE LIABLE FOR INCIDENTAL, CONSEQUENTIAL, INDIRECT, SPECIAL, OR PUNITIVE DAMAGES OF ANY KIND, OR FOR LOSS OF REVENUE, LOSS OF BUSINESS, OR OTHER FINANCIAL LOSS ARISING OUT OF OR IN CONNECTION WITH THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE, FAILURE, OR INTERRUPTION OF ITS PRODUCTS, EVEN IF 3COM OR ITS AUTHORIZED RESELLER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

Some states do not allow the exclusion of implied warranties or the limitation of incidental or consequential damages for consumer products, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights which may vary from state to state. 

GOVERNING LAW: This Limited Warranty shall be governed by the laws of the state of California. 

3Com Corporation
5400 Bayfront Plaza
Santa Clara, CA 95052-8145
(408) 764-5000
1/1/94 
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